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Paper Set 1 · 22 May 2026 · 9:00 AM - 10:30 AM · OSSSC CRE 2025 (English)

Quant

✓

Q1 Quant
Arman starts a business with ₹56,000. After 5 months, Raman joined
him with ₹64,000. At the end of the year, what will the profit share of
Raman be, out of the annual profit of ₹24,500?

A.  D. ₹9,100

B.  C. ₹9,300

C.  A. ₹9,700

D.  B. ₹9,800

✓

Q2 Quant
Two trains, A and B, are travelling towards each other. Train A is
travelling at a speed of 'x' km/hr, and train B is traveling at a speed
of (x + 20) km/hr. They start from points 300 km apart and meet after
2 hours. What is the speed of the two trains, A and B, respectively?

A.  A. 25 km/hr and 45 km/hr

B.  C. 40 km/hr and 60 km/hr

C.  D. 65 km/hr and 85 km/hr

D.  B. 60 km/hr and 80 km/hr

✓

Q3 Quant
A and B can do a piece of work in 20 days and 15 days, respectively.
With the help of C, they finish the work in 5 days. How long will C
alone take to finish the work?

A.  D. 8 days

B.  C. 10 days

C.  A. 12 days

D.  B. 18 days

✓

Q4 Quant
A and B invest in a business in the ratio 5:7. The total profit after one
year is ₹2,400. Find B’s share of the profit.

A.  B. ₹1,200

B.  D. ₹1,400

C.  C. ₹1,500

D.  A. ₹1,600

✓

Q5 Quant
In quadrilateral PQRS, PL and RM are perpendiculars to the diagonal
QS. Find the length of the perpendicular RM if QS = 24 cm, PL = 6 cm
and area of quadrilateral PQRS = 272 cm2. (Give your answer in cm,
rounded off to two decimal places.)

A.  B. 12.75 cm

B.  C. 13.64 cm

C.  A. 15.52 cm

D.  D. 16.67 cm

✓

Q6 Quant
Walking at a speed of 3 km/hr, a boy reaches his school 4 minutes
late. Walking at 4 km/hr, he reaches there 1 minute early. The
distance of his school from the start point is:

A.  D. 0.5 km

B.  B. 1 km

C.  A. 1.5 km

D.  C. 2 km

✓

Q7 Quant
Four friends, A, B, C, and D, are of different ages. The ratio of A’s age
to B’s age is 2 : 3, the ratio of B’s age to C’s age is 4 : 5, and the ratio
of C’s age to D’s age is 3 : 2. If the sum of ages of all four friends is
90 years, the difference between youngest and oldest friends' ages
is

A.  12 years

B.  14 years

C.  16 years

D.  18 years

✓

Q8 Quant
The sum of two numbers is 24 and their difference is 12. Find the
bigger number from the two.

A.  C. 18

B.  B. 16

C.  D. 14

D.  A. 12
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✓

Q9 Quant
A swimming pool is 24 m long, 18 m wide and 4.5 m deep. Find the
cost (in ₹) of repairing its floor and walls at the rate of ₹87.50 per
m2.

A.  A. ₹70,075

B.  B. ₹70,875

C.  C. ₹72,205

D.  D. ₹72,695

✓

Q10 Quant
The price of a laptop is increased by 25% and then decreased by
12%. If the initial price of the laptop is ₹78,000, what is the final
price of the laptop?

A.  B. ₹85,400

B.  C. ₹85,600

C.  D. ₹85,800

D.  A. ₹86,000

✓

Q11 Quant
The arithmetic mean of the numbers 10, 18, 24, (30+a), and (36-a),
where, a>0, is

A.  B. 22.6

B.  C. 23.6

C.  D. 24.6

D.  A. 25.6

✓

Q12 Quant
One pipe can fill a tank in 12 minutes while another pipe can empty
the completely filled tank in 18 minutes. If both the pipes are
opened together when the tank is empty, how many minutes will it
take to fill one-third of the tank?

A.  C. 12

B.  B. 24

C.  D. 36

D.  A. 48

✓

Q13 Quant

If the simple interest for 2 years is ₹78 and the compound interest
for the same period is ₹81 at the same rate, what is the principal (in
₹)?

A.  C. 507

B.  D. 502

C.  A. 500

D.  B. 511

✓

Q14 Quant
In what time (in months) will ₹3,000 fetch an interest of ₹400 at 5%
per year simple interest?

A.  D. 32

B.  B. 29

C.  C. 30

D.  A. 36

✓

Q15 Quant
A refrigerator has a list price of ₹25,000. A retailer purchases it after
receiving two successive discounts of 2% and 20%, and this becomes
his cost price. He wants to earn a profit of 46% on his cost price. If
he allows a discount of 30% on his marked price to customers, at
what price should he mark the refrigerator?

A.  C. ₹40,880

B.  D. ₹40,774

C.  B. ₹40,891

D.  A. ₹40,819
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✓

Q16 Quant
A trader bought 25 mangoes for ₹750 and sold them at ₹35 each. Find his profit percentage.

A.  

B.  

C.  

D.  

✓

Q17 Quant

A.  

B.  

C.  

D.  

✓

Q18 Quant
A Laptop is bought for ₹50,000 and sold for ₹62,500. Find the profit percentage.

A.  

B.  

C.  

D.  
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✓

Q19 Quant
The ratio of the lengths of two corresponding sides of two similar triangles is 1 : 3. The ratio of the areas of these two triangles, in the order
mentioned, is:1099

A.  D. 1 : 9

B.  C. 1 : 3

C.  

D.  A. 9 : 1

✓

Q20 Quant

A.  

B.  

C.  

D.  

GA

✓

Q21 GA
Who amongst the following was not a member of the cabinet
mission plan in India in 1946?

A.  B. Sir Pethick-Lawrence

B.  C. A.V Alexander

C.  D. Sir Stafford Cripps

D.  A. Lord Canning

✓

Q22 GA
According to Odisha Economic Survey 2024-25, Odisha ranked first
in India for outward movement of commodities in which year?

A.  B. 2020-21

B.  C. 2021-22

C.  A. 2022-23

D.  D. 2023-24

✓

Q23 GA
The Gotipua tradition—an antecedent to Odissi—features:

A.  C. Married couples dancing together

B.  B. Pre-pubescent boys dancing in female costume

C.  A. Monks performing ritual mime

D.  D. Martial dancers with swords and shields.

✓

Q24 GA
Project Tiger was launched in India in which year?

A.  C. 1971

B.  D. 1973

C.  B. 1975

D.  A. 1977

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
https://rank.qmaths.in


✓

Q25 GA
Under Swachh Survekshan 2024-25, which small towns from Ganjam
won top honours (state/national) for cleanliness?

A.  B. Hinjilicut & Polasara

B.  A. Aska & Chikiti

C.  C. Bhanjanagar & Chatrapur

D.  D. Berhampur & Buguda

✓

Q26 GA
In June 2025, S Mahendra Dev was appointed as the chairman of
which of the following organisations/institutions?

A.  D. Economic Advisory Council to the Prime Minister

B.  B. National Judicial Appoinments Commission

C.  C. Chief Advisory Council to the Lokpal of India

D.  A. Ex-officio chairman of State Bank of India

✓

Q27 GA
Where was Odisha’s first seawater desalination plant inaugurated in
2025?

A.  C. Ganjam district

B.  D. Kendrapara district

C.  A. Bhadrak district

D.  B. Balasore district

✓

Q28 GA
Which country qualified for the 2026 FIFA World Cup, setting up
Cristiano Ronaldo for a record sixth appearance?

A.  A. France

B.  C. Germany

C.  B. Italy

D.  D. Portugal

✓

Q29 GA
Which body/bodies did the Supreme Court direct in December 2025
to implement 30% reservation for women?

A.  D. Bar Councils

B.  A. High Courts

C.  B. Parliament

D.  C. Police

✓

Q30 GA
In October 2025, which vessel was commissioned as the second
Anti-Submarine Warfare Shallow Water Craft at Visakhapatnam?

A.  C. INS Androth

B.  B. INS Kavaratti

C.  A. INS Kiltan

D.  D. INS Kadmatt

✓

Q31 GA
Which of the following athletes became the first Indian to win a
medal at the World Athletics Championships in 2003?

A.  D. P. T. Usha

B.  B. Milkha Singh

C.  A. Anju Bobby George

D.  C. Shankar Gupta

✓

Q32 GA
A student wants to model the transfer of genetic information in a
cell. Which structure should they focus on?

A.  A. Mitochondria

B.  D. Nucleus

C.  B. Ribosome

D.  C. Cell wall

✓

Q33 GA
Which landform is created mainly by the deposition of sand and silt
at the mouth of a river?

A.  A. A delta

B.  B. A canyon

C.  D. A peninsula

D.  C. A glacier

✓

Q34 GA
The Mini-Constitution label is given to which Amendment of the
Indian Constitution?

A.  D. 22nd Amendment

B.  B. 32nd Amendment

C.  C. 42nd Amendment

D.  A. 52nd Amendment
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✓

Q35 GA
A person is considered below poverty line when __________.

A.  B. Income remains above average levels

B.  A. Consumption includes luxury goods only

C.  C. Income/Consumption is below basic needs level

D.  D. Employment remains within informal sector

✓

Q36 GA
How does the acceleration due to gravity (g) change if the mass of a
planet is doubled while its radius remains unchanged?

A.  A. It is halved

B.  C. It remains the same

C.  D. It doubles

D.  B. It becomes four times larger

✓

Q37 GA
Which language was primarily used in medieval court literature
under the Delhi Sultanate?

A.  B. Sanskrit

B.  A. Persian

C.  D. Hindi

D.  C. Tamil

✓

Q38 GA
When ethanol is heated with excess concentrated sulphuric acid at
443 K, it forms ethene. What is the role of concentrated sulphuric
acid in this reaction?

A.  C. It removes water.

B.  D. It adds oxygen.

C.  B. It adds hydrogen.

D.  A. It cools the reaction.

✓

Q39 GA
The Pancheshwar Multi Purpose project is an initiative of sharing
water and electricity between India and which country?

A.  A. China

B.  B. Bhutan

C.  D. Bangladesh

D.  C. Nepal

✓

Q40 GA
How many Indian states share its border with Nepal?

A.  B. 6

B.  A. 2

C.  D. 8

D.  C. 5

English

✓

Q41 English
Select the most appropriate meaning of the given word.

Gourmand

A.  A. A lover of good sleep

B.  C. A lover of good food

C.  B. A lover of good ideas

D.  D. A lover of good deeds

✓

Q42 English
Select the most appropriate article to fill in the blank. If no article is required, select ‘No article needed’.

______ silence in the room was broken by the sound of footsteps.

A.  A. A

B.  B. The

C.  D. An

D.  C. No article needed
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Q43 English
Select the most appropriate option that rectifies the underlined incorrectly spelt word in the given sentence.

She recieved a letter from her friend yesterday.

A.  A. Reiceved

B.  D. Recived

C.  B. Received

D.  C. Receved

✓

Q44 English
Select the option that expresses the given sentence in passive voice.

They will complete the assignment by tomorrow.

A.  B. The assignment is completed by them by tomorrow.

B.  D. The assignment has been completed by tomorrow.

C.  A. The assignment will be completed by them by tomorrow.

D.  C. The assignment would be completed by them by tomorrow.

✓

Q45 English
Select the option that can be used as a one-word substitute for the given group of words.

A disease that spreads over a large area affecting many people

A.  C. Epidemic

B.  D. Contagion

C.  A. Endemic

D.  B. Pandemic

✓

Q46 English
Choose the most suitable idiom for the highlighted words in the given sentence.

He was trembling with extreme fear after stealing the money from his master’s shelf and attempting to deceive him.

A.  C. shaking in his shoes

B.  B. pulling his leg

C.  D. standing on his own two feet

D.  A. walking on air

✓

Q47 English
Select the most appropriate proverb to substitute the highlighted segment in the given sentence.

The supervisor stated that individuals who raise repeated complaints are more likely to attract attention.

A.  D. the squeaky wheel gets the grease

B.  A. necessity is the mother of invention

C.  B. you can’t teach an old dog new tricks

D.  C. a stitch in time saves nine

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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Q48 English
Choose the correct indirect narration of the given sentence and fill in the blank.
Sneha said, “I like ice cream.”
Sneha said ________________________.

A.  A. that I like ice cream.

B.  B. that she has liked ice cream.

C.  C. that she is liking ice cream.

D.  D. that she liked ice cream.

✓

Q49 English
Parts of a sentence are given below. While the first and the last part (S1) and (S6) are in correct order, the parts in between are jumbled up.
Arrange the parts in the correct order to form a meaningful sentence
S1. She explained that
P. the workshop was to enhance
Q. attend all sessions to
R. skills, participants should
S. since the purpose of
S6. maximize learning benefits.

A.  B. QSRP

B.  C. RQPS

C.  A. SPRQ

D.  D. PQSR

✓

Q50 English
Complete the sentence by choosing the correct option.
One should never be cruel ....... animals.

A.  A. by

B.  C. to

C.  B. at

D.  D. among

✓

Q51 English
Choose the word opposite in meaning to the underlined word in the given sentence.

After a long drought, the farmers were relieved to see the abundant harvest.

A.  C. Crowded

B.  B. Plenteous

C.  A. Meager

D.  D. Generous

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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Q52 English
In the following question choose the word opposite in meaning to the underlined word.
The new policy proved to be detrimental to the growth of small businesses.

A.  D. harmful

B.  B. beneficial

C.  A. contagious

D.  C. malignant

✓

Q53 English
Parts of a sentence are given below in jumbled order. Arrange the parts in the correct order to form a meaningful sentence.

(a) earth today
(b) the biggest threats
(c) pollution is one of
(d) to life on

A.  C. bdac

B.  D. cbda

C.  A. acdb

D.  B. dacb

✓

Q54 English

Read the given passage and answer the questions that follow.

The city park is a favourite spot for many families, morning joggers and nature lovers. Every morning, people from nearby neighbourhoods come
to jog, walk their dogs, stretch or simply enjoy the calm, fresh air. Children laugh and play on the swings, see-saws and colourful slides, while
elderly people sit peacefully on benches, reading newspapers or chatting with old friends. The park is always well maintained, with blooming
seasonal flowers adding charm throughout the year and birds chirping merrily in the trees. It provides a peaceful and refreshing escape from the
noise, traffic and stress of daily city life. Local volunteers frequently organise weekend clean-up drives to keep the park neat, clean and green.
The entire community values this shared green space, as it encourages health, happiness, bonding and a strong sense of togetherness among all
residents.

What activities do people commonly do in the city park?

A.  B. Jogging and dog walking

B.  D. Shopping

C.  A. Driving cars

D.  C. Cooking food

✓

Q55 English
What can be inferred about the role of the park in the community?

A.  B. It is a place for relaxation and social interaction.

B.  C. It is a place for loud parties.

C.  A. It is rarely used by people.

D.  D. It is a commercial market.

https://play.google.com/store/apps/details?id=in.qmaths.blackbook&referrer=src%3Dosssc_cre25
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Q56 English
What is the main theme of the passage?

A.  C. Importance of green spaces for community well-being

B.  A. History of the city park

C.  B. Economic development of the city

D.  D. Wildlife conservation

✓

Q57 English
Select the word that is the opposite of ‘peaceful’ as used in the passage.

A.  A. Calm

B.  C. Quiet

C.  D. Noisy

D.  B. Serene

✓

Q58 English
What is the tone of the passage?

A.  C. Critical

B.  A. Negative

C.  B. Appreciative

D.  D. Indifferent

✓

Q59 English
Select the sentence that correctly uses the past perfect tense.

A.  A. She had finished her homework before the guests arrived.

B.  D. She finished her homework before the guests will arrive.

C.  C. She has finished her homework before the guests arrived.

D.  B. She was finishing her homework before the guests arrive.

✓

Q60 English

Select the most appropriate verb to fill in the blank.

The interns ______ the project on time to their guide.

A.  A. hand in

B.  C. hand over

C.  D. hands in

D.  B. handed in
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Odia

✓

Q61 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ନି ର୍ବା ଚନ ଆୟୋଗ ସ୍ୱତନ୍ତ୍ର ଏବଂ ନି ସ୍ପକ୍ଷ ନି ର୍ବା ଚନ ଅନୁ ଷ୍ଠି ତ କରାଇଥାଏ ।

A.  B. The Election Commission conducts free and fair elections.

B.  C. The Election Commission controls the army.

C.  A. The Election Commission makes new laws.

D.  D. The Election Commission approves bills in Parliament.

✓

Q62 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ଡାଲଖାଇ ନୃ ତ୍ୟ ଓଡ଼ି ଶାର ଏକ ଲୋକନୃ ତ୍ୟ ଅଟେ ।

A.  D. Dalkhai dance is a folk dance of Odisha.

B.  C. Dalkhai dances are folk of Odisha.

C.  A. Dalkhai is one folk dancing from Odishas.

D.  B. The Dalkhai dance be folk dance Odisha.

✓

Q63 Odia
ନି ମ୍ନ ଲି ଖି ତ ବି କଳ୍ପଗୁ ଡ଼ି କ ମଧ୍ୟରୁ  ଦି ଆଯାଇଥି ବା ଓଡ଼ି ଆ ବାକ୍ୟର ସଠି କ୍  ଇଂରାଜୀ ଅନୁ ବାଦ ବାଛନ୍ତୁ:
ବୌଦ୍ଧ ଧର୍ମ  ଏହାର ଅନୁ ଗାମୀଙ୍କୁ  ଦୈ ନନ୍ଦି ନ ଜୀବନରେ ଶାନ୍ତି  ଏବଂ ଅହିଂ ସା ପାଳନ କରି ବା ପାଇଁ  ଶି କ୍ଷା ଦେଇଥାଏ ।

A.  B. Buddhism teaches followers to practice peace and non-violence in daily life.

B.  A. Buddhism teach followers to practice peace and non-violence in daily life.

C.  D. Buddhism teaches follower to practice peace and non-violence in daily life.

D.  C. Buddhism teaches followers to practice peace and non-violence in daily lifes.
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Q64 Odia

ନି ମ୍ନ ଲି ଖି ତ ଅନୁ ଚ୍ଛେଦର ବି ଷୟବସ୍ତୁକୁ  ଭଲଭାବରେ ପଢ । ତା ତଳେ ପ୍ର ଦତ୍ତ ପ୍ର ତ୍ୟେକ ପ୍ର ଶ୍ନ ର ଚାରି ଟି  ସମ୍ଭାବି ତ ଉତ୍ତର ମଧ୍ୟରୁ  ସଠି କ ଉତ୍ତରକୁ  ଚୟନ କରନ୍ତୁ

ବୈ ଦି କ ଯୁ ଗ ପ୍ରା ଚୀନ ଭାରତୀୟ ଇତି ହାସର ସବୁ ଠାରୁ  ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ସମୟ ମଧ୍ୟରୁ  ଅନ୍ୟତମ , ଯାହା ପ୍ରା ୟ ଖ୍ରୀ ଷ୍ଟପୂ ର୍ବ  1500 ରୁ  ଖ୍ରୀ ଷ୍ଟପୂ ର୍ବ  600 ପର୍ଯ୍ୟ ନ୍ତ ବ୍ୟାପି ଛି  । ଏହି  ଯୁ ଗର ନାମ ହି ନ୍ଦୁ  ଧର୍ମ ର
ସର୍ବ ପ୍ରା ଚୀନ ପବି ତ୍ର  ଗ୍ର ନ୍ଥ ବେଦରୁ  ଆସି ଛି  । ଏହି  ଯୁ ଗକୁ  ବୁ ଝି ବା ପାଇଁ  ଏହା ମୁ ଖ୍ୟ ସାହି ତ୍ୟି କ ଉତ୍ସ ଭାବରେ କାର୍ଯ୍ୟ  କରେ। ବୈ ଦି କ ଯୁ ଗକୁ  ସାଧାରଣତଃ ଦୁ ଇଟି  ପର୍ଯ୍ୟା ୟରେ ବି ଭକ୍ତ କରାଯାଇଛି  -
ପ୍ରା ରମ୍ଭି କ ବୈ ଦି କ ଯୁ ଗ (ଖ୍ରୀ ଷ୍ଟପୂ ର୍ବ  1500-1000 ) ଏବଂ ପରବର୍ତ୍ତୀ  ବୈ ଦି କ ଯୁ ଗ (ଖ୍ରୀ ଷ୍ଟପୂ ର୍ବ  1000-600 )। ଇଣ୍ଡୋ-ୟୁ ରୋପୀୟ ଭାଷାଭାଷୀ ଲୋକଙ୍କ ଏକ ଗୋଷ୍ଠୀ, ଆର୍ଯ୍ୟ ମାନେ ଏହି  ସମୟରେ
ଉତ୍ତର-ପଶ୍ଚି ମ ଭାରତରେ ପ୍ର ବାସ କରି ଥି ଲେ ଏବଂ ସରସ୍ୱତୀ ନଦୀ ଏବଂ ପରେ ଗଙ୍ଗା ନଦୀ କୂ ଳରେ ବସତି  ସ୍ଥାପନ କରି ଥି ଲେ ବୋଲି  ବି ଶ୍ୱାସ କରାଯାଏ।

ପ୍ରା ଚୀନ ବୈ ଦି କ ଯୁ ଗରେ, ସମାଜ ମୁ ଖ୍ୟତଃ ପଶୁ ପାଳକ ଥି ଲା, ଧନର ମୁ ଖ୍ୟ ମାପକାଠି  ଭାବରେ ଗୋରୁ ଗାଈ କାମ କରୁ ଥି ଲେ। ଲୋକମାନେ ଜନ ନାମକ ଛୋଟ ଆଦି ବାସୀ ସମ୍ପ୍ରଦାୟରେ ରହୁ ଥି ଲେ
ଏବଂ ନେତୃ ତ୍ୱ ସାଧାରଣତଃ ରାଜା ନାମରେ ଜଣାଶୁ ଣା ମୁ ଖ୍ୟଙ୍କ ଉପରେ ନ୍ୟସ୍ତ ଥି ଲା। ଅର୍ଥ ନୀତି  ମୁ ଖ୍ୟତଃ କୃ ଷି , ଗୋପାଳନ ଏବଂ ଜି ନି ଷପତ୍ର  ଦ୍ୱାରା ବାଣି ଜ୍ୟ ଉପରେ ନି ର୍ଭ ର କରୁ ଥି ଲା। ଚାରି  ବେଦ
ମଧ୍ୟରୁ  ସର୍ବ ପ୍ରା ଚୀନ ଋଗ ବେଦ ସମୟର ରାଜନୈ ତି କ, ସାମାଜି କ ଏବଂ ଧାର୍ମିକ ଜୀବନ ବି ଷୟରେ ଦର୍ଶା ଇଥାଏ । ପ୍ରା ରମ୍ଭି କ ବୈ ଦି କ ଲୋକମାନଙ୍କ ଧର୍ମ  ସରଳ ଏବଂ ପ୍ର କୃ ତି -ଆଧାରି ତ ଥି ଲା;
ସେମାନେ ଋତି -ନୀତି  ଓ ବଳି  ଦାନ ମାଧ୍ୟମରେ ଇନ୍ଦ୍ର (ବର୍ଷା  ଏବଂ ଯୁ ଦ୍ଧର ଦେବତା), ଅଗ୍ନି  (ଅଗ୍ନି  ଦେବତା), ଏବଂ ବରୁ ଣ (ମହାଜାନି  କ୍ର ମର ଦେବତା) ପରି  ପ୍ର କୃ ତି ର ଶକ୍ତି ଗୁ ଡ଼ି କୁ  ପୂ ଜା କରୁ ଥି ଲେ ।

ପରବର୍ତ୍ତୀ  ବୈ ଦି କ ଯୁ ଗରେ ସମାଜ ଏବଂ ରାଜନୀତି ରେ ଗୁ ରୁ ତ୍ୱପୂ ର୍ଣ୍ଣ  ପରି ବର୍ତ୍ତ ନ ଦେଖାଯାଇଥି ଲା। ଆର୍ଯ୍ୟ ମାନେ ପୂ ର୍ବ  ଦି ଗରେ ଗଙ୍ଗାର ଉର୍ବ ର ସମତଳ ଭୂ ମି ରେ ବି ସ୍ତାର କରି ଥି ଲେ, ଯାହା ଫଳରେ ବଡ଼
ରାଜ୍ୟ କି ମ୍ବା ମହାଜନପଦର ବି କାଶ ହୋଇଥି ଲା। ସମାଜ ଅଧି କ ଜଟି ଳ ହୋଇଗଲା, ଏବଂ ବର୍ଣ୍ଣ  ବ୍ୟବସ୍ଥା କି ମ୍ବା ଶ୍ର ମ ବି ଭାଜନ ଏକ କଠୋର ଜାତି  ପଦାନୁ କ୍ର ମରେ ବି କଶି ତ ହେଲା। ରାଜତ୍ୱ ଅଧି କ
ଶକ୍ତି ଶାଳୀ ହୋଇଗଲା, କୃ ଷି  ଅଧି କ ଉନ୍ନତ ହେଲା, ଏବଂ ଲୁ ହା ଉପକରଣର ବ୍ୟବହାର ଉତ୍ପାଦକତା ବୃ ଦ୍ଧି  କଲା। ଏହି  ସମୟର ଦାର୍ଶ ନି କ ଚି ନ୍ତାଧାରା ହି ନ୍ଦୁ  ଦର୍ଶ ନ ଏବଂ ଉପନି ଷଦର ମୂ ଳଦୁ ଆ
ପକାଇଲା, ଯାହା ଆଧ୍ୟାତ୍ମି କ ଜ୍ଞାନ ଏବଂ ଆତ୍ମ-ସାକ୍ଷାତ ଉପରେ ଗୁ ରୁ ତ୍ୱ ଦେଇଥି ଲା।

ବୈ ଦି କ ଯୁ ଗ କେଉଁ  ଗ୍ର ନ୍ଥ ଗୋଷ୍ଠୀ ଅନୁ ସାରେ ନାମି ତ ହୋଇଛି ?

A.  D. ପୁ ରାଣ

B.  B. ମହାକାବ୍ୟ

C.  A. ବେଦ

D.  C. ଉପନି ଷଦ

✓

Q65 Odia
ଋଗ ବେଦ ବୈ ଦି କ ଯୁ ଗର କେଉଁ  ସମୟ ସହି ତ ଜଡି ତ?

A.  C. ପରବର୍ତ୍ତୀ  ବୈ ଦି କ ଯୁ ଗ

B.  A. ପ୍ରା ରମ୍ଭି କ ବୈ ଦି କ ଯୁ ଗ

C.  B. ଉତ୍ତର-ବୈ ଦି କ ଯୁ ଗ

D.  D. ଗୁ ପ୍ତ ଯୁ ଗ

✓

Q66 Odia
ଋଗ ବେଦି କ ଆର୍ଯ୍ୟ  ମାନଙ୍କର ମୁ ଖ୍ୟ ଦେବତା କି ଏ ଥି ଲେ?

A.  A. ବି ଷ୍ଣୁ

B.  B. ଶି ବ

C.  D. ଇନ୍ଦ୍ର

D.  C. ବ୍ର ହ୍ମା

✓

Q67 Odia
ପରବର୍ତ୍ତୀ  ବୈ ଦି କ ଯୁ ଗରେ କଣ ବି କାଶ ହୋଇଥି ଲା ?

A.  C. ମହାଜନପଦ

B.  D. ହରପ୍ପା ସହର

C.  A. ବୌଦ୍ଧ ମଠ

D.  B. ମୋଗଲ ପ୍ର ଦେଶ
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✓

Q68 Odia
ପରବର୍ତ୍ତୀ  ବୈ ଦି କ ଯୁ ଗରେ କେଉଁ  ଧାତୁ  ପ୍ର ମୁ ଖ ହୋଇଥି ଲା?

A.  D. ତମ୍ବା

B.  A. ସୁ ନା

C.  C. ଲୁ ହା

D.  B. ରୂ ପା

✓

Q69 Odia
"ଓଟ ମୁ ହଁ ରେ ଜୀରା"- ଏହି  ଲୋକୋକ୍ତି ର ଠି କ୍  ଅର୍ଥ  କଣ ?

A.  A. ବହୁ ତ ଖାଦ୍ୟ ଥି ଲେ ମଧ୍ୟ ଭୋକ ନ ମେଣ୍ଟି ବା ।

B.  D. ବେଶି  ଚାହୁଁ ଥି ବା ଲୋକକୁ  କମ୍  ଦେବା ।

C.  B. ଆବଶ୍ୟକତା ଅନୁ ସାରେ ଯଥେଷ୍ଟ ମି ଳି ବା ।

D.  C. ଅଳ୍ପ ଖାଇଲେ ମଧ୍ୟ ସନ୍ତୁଷ୍ଟ ହେବା ।

✓

Q70 Odia
'ରଘୁ  ବାବୁ ଙ୍କର ସୌଜନ୍ୟତା ଅତ୍ୟନ୍ତ ପ୍ର ଶଂସନୀୟ' - ଏହି  ବାକ୍ୟରେ ଥି ବା ଅଶୁ ଦ୍ଧ ପଦକୁ  ଚି ହ୍ନଟ କର।

A.  D. ରଘୁ  ବାବୁ ଙ୍କର

B.  A. ସୌଜନ୍ୟତା

C.  B. ପ୍ର ଶଂସନୀୟ

D.  C. ଅତ୍ୟନ୍ତ

✓

Q71 Odia
"ଝରଣାଟି  କଳକଳ ନାଦରେ ବହି ଯାଉଛି " 'କଳକଳ' କେଉଁ  ପ୍ର କାର କ୍ରି  ୟା ବି ଶେଷଣ?

A.  D. ସ୍ଥାନବାଚକ

B.  B. ଶବ୍ଦାନୁ କାରୀ ରୀତି ବାଚକ

C.  C. କାଳବାଚକ

D.  A. ପରି ମାଣବାଚକ

✓

Q72 Odia
ଠି କ୍  ଶବ୍ଦଟି  ଚି ହ୍ନାଇ ଦି ଅ?

A.  C. ଦି ଗମାର

B.  A. ଦି ଗମ୍ବର

C.  B. ଦି ଗାମ୍ବର

D.  D. ଦୀଗାମ୍ବର

✓

Q73 Odia
କହି ବା ସହଜ, ଅଥଚ କାମରେ କରି ବା କଷ୍ଟ ।- ଉକ୍ତ ବାକ୍ୟ ମଧ୍ୟରେ କେଉଁ  ପ୍ର କାର ଅବ୍ୟୟ ପଦ ବ୍ୟବହାର କରାଯାଇଛି  ।

A.  C. ସଂଯୋଜକ ଅବ୍ୟୟ

B.  A. ବି ଯୋଜକ ଅବ୍ୟୟ

C.  D. ପଦାନ୍ୱ ୟୀ ଅବ୍ୟୟ

D.  B. ବି କଳ୍ପାର୍ଥ କ ଅବ୍ୟୟ
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✓

Q74 Odia
ଯେଉଁ  ଅବ୍ୟୟ ପଦ ଦୁ ଇଟି  ବାକ୍ୟର ଅର୍ଥ କୁ  ବି ଯୋଜନ କରେ, ତାକୁ  ------------ ଅବ୍ୟୟ କହନ୍ତି  ।

A.  B. ବି ଯୋଜକ ଅବ୍ୟୟ

B.  C. ସଂଯୋଜକ ଅବ୍ୟୟ

C.  D. ଭାବସୂ ଚକ ଅବ୍ୟୟ

D.  A. କାଳସୂ ଚକ ଅବ୍ୟୟ

✓

Q75 Odia
ନି ମ୍ନ ଲି ଖି ତ ମଧ୍ୟରୁ  'ଅକ୍ଲା ନ୍ତ' ଶଦ୍ଦର ବି ପରୀତ କେଉଁ ଟି  ?

A.  C. ଶକ୍ତି ଶାଳୀ

B.  B. ଅଳସ

C.  D. ସୁ ସ୍ଥ

D.  A. କ୍ଲା ନ୍ତ

Computer

✓

Q76 Computer
What part of the Windows desktop shows open applications and the
Start button?

A.  C. Status Bar

B.  B. Menu Bar

C.  A. Taskbar

D.  D. Title Bar

✓

Q77 Computer
A student is drafting an essay in MS Word 365 and has several
instances of correctly spelled but misused words (e.g., writing
"their" when they meant "there"). Which specific feature must be
enabled or configured in Word's options to ensure these types of
grammatical or contextual errors are identified, rather than just
simple typographical errors?

A.  B. Ensure the document's Proofing Language is set to
"English."

B.  D. Enable the "Ignore words in UPPERCASE" rule under
Grammar Settings.

C.  A. Ensure "Mark grammar errors as you type" is selected, and
set the Writing Style to "Grammar & Refinements."

D.  C. Manually add all potential homophones to the document's
Custom Dictionary.

✓

Q78 Computer
When opening a workbook in Microsoft Excel 2020 to view its data
without making changes, which option should you select?

A.  C. Open in Read-Only Mode

B.  B. Open in Edit Mode

C.  A. Create a New Workbook

D.  D. Open as Template

✓

Q79 Computer
Which file path identifies the complete location from the root
directory?

A.  B. Relative path

B.  C. Metadata

C.  D. Absolute path

D.  A. Directories

✓

Q80 Computer
Which option, under the Settings app in Windows OS, is used to
change the screen resolution of the display?

A.  B. Network & Internet

B.  D. Personalization

C.  A. Display Settings

D.  C. System
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✓

Q81 Computer
What is application software?

A.  C. Software used to manage computer hardware

B.  B. Software used to support system software

C.  A. Software designed to perform specific user tasks

D.  D. Software used to boot the operating system

✓

Q82 Computer
What is the difference between 'To' and 'CC' in an email?

A.  C. 'To' is for the main recipient, while 'CC' is for additional
recipients.

B.  A. 'To' is for attachments, while 'CC' is for the subject.

C.  B. 'To' is for blocking spam, while 'CC' is for sending emails.

D.  D. There is no difference.

✓

Q83 Computer
Cell A followed by row 5 is called as ___.

A.  B. A6

B.  C. 6A

C.  D. A5

D.  A. 5A

✓

Q84 Computer
What is the difference between "Save" and "Save As" in MS Word?

A.  A. Both do the same thing

B.  D. "Save As" is used only when printing

C.  B. "Save" updates the current file, while "Save As" creates a
new file

D.  C. "Save As" deletes the original file

✓

Q85 Computer
How can you change/modify a template from a MS PowerPoint 2021
presentation?

A.  C. Go to the Design tab, click More, and select Remove
Template

B.  D. Go to the View tab, click Slide Master, and delete the
applied template

C.  A. PowerPoint does not allow you to remove a template once
applied

D.  B. Right-click on the template in the Design tab and choose
Remove

✓

Q86 Computer
What is the first slide you see when you create a new presentation
using the Blank Presentation option?

A.  A. Content slide

B.  C. Summary slide

C.  B. Master Slide

D.  D. Title Slide

✓

Q87 Computer
Which of the following correctly represents the structure of an email
address?

A.  D. <domain-name>@<username>

B.  A. <username>#<domain-name>

C.  B. <username>@<domain-name>

D.  C. <domain-name>/<username>

✓

Q88 Computer
Which of the following options is NOT listed under the 'Print All
Pages' dropdown in MS Word 2021?

A.  D. Custom Print

B.  B. Print Selection

C.  C. Print All Pages

D.  A. Print Hidden Text

✓

Q89 Computer
Which of the following is NOT a way to start a new MS Excel
workbook?

A.  C. Ctrl + N

B.  B. File > New > Blank Workbook

C.  A. Double-clicking on the MS Excel icon

D.  D. Ctrl + P

✓

Q90 Computer
In applying the template to all existing slides, which of the following
shortcut key combinations is used to select all the slides in MS
PowerPoint?

A.  A. Ctrl+A

B.  B. Alt+C

C.  D. Ctrl+F

D.  C. Alt+A
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Q91 Reasoning
In a straight seating arrangement, 4 friends (Ram, Arjun, Mohan and
Sham) are sitting in a row facing north. Ram is sitting to the
immediate right of Arjun, and Mohan is sitting to the immediate left
of Sham. Arjun is not an immediate neighbour of Sham. Which of
the following is the position of Sham?

A.  B. Sits at the extreme left end

B.  A. Sits at the extreme right end

C.  C. Sits second to the right of Arjun

D.  D. Sits between Arjun and Mohan

✓

Q92 Reasoning
NERD is related to LCVH in a certain way based on the English
alphabetical order. In the same way, JAZL is related to HYDP. To
which of the following is FWHT related, following the same logic?

A.  A. CUKY

B.  B. EVLW

C.  D. DULX

D.  C. ETMX

✓

Q93 Reasoning
Seven boxes Q, R, W, T, E, U, and Y are kept one over the other but
not necessarily in the same order.
T is kept immediately above Y. U is kept immediately above R. Only
Q is kept above W. Only two boxes are kept above T. U is not kept at
the third position from the bottom.
How many boxes are kept above U?

A.  B. 2

B.  D. 3

C.  C. 4

D.  A. 5

✓

Q94 Reasoning
If ‘A’ stands for ‘÷’, ‘B’ stands for ‘×’, ‘C’ stands for ‘+’ and ‘D’ stands for
‘−’, then what will come in place of the question mark ‘?’ in the
following equation?

(56 A 8) B 2 C (14 A 7) B 5 D 10 = ?

A.  D. 24

B.  A. 14

C.  B. 18

D.  C. 32

✓

Q95 Reasoning
Which of the following options will replace the question mark (?) in
the given series to make it logically complete?

GEAC CAWY ? USOQ QOKM

A.  A. YWSU

B.  B. QPJL

C.  C. QNJL

D.  D. QRTV

✓

Q96 Reasoning
In a certain code language,
A @ B means ‘A is the father of B’
A & B means ‘A is the daughter of B’
A # B means ‘A is the son of B’
A % B means ‘A is the brother of B’

Based on the above, how is P related to T if ‘P # Q % R & S @ T’?

A.  D. Mother’s father

B.  B. Brother’s son

C.  C. Father

D.  A. Father’s brother

✓

Q97 Reasoning
In a certain code language, 'RETL' is coded as '40' and 'KAVQ' is
coded as '44'.
What is the code for 'YNSI' in the given code language?

A.  A. 31

B.  B. 28

C.  D. 40

D.  C. 34

✓

Q98 Reasoning
Read the given statement(s) and conclusions carefully. Assuming
that the information given in the statements is true, even if it
appears to be at variance with commonly known facts, decide which
of the given conclusions logically follow(s) from the statement(s).
Statement: All Valves are Taps. No Taps are Fountains.
Conclusion I: No Fountains are Valves
Conclusion II: Some Fountains are Valves

A.  B. Only conclusion (I) follows

B.  D. Only conclusion (II) follows

C.  A. Neither conclusion (I) nor (II) follows

D.  C. Both conclusions (I) and (II) follow
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Q99 Reasoning
Based on the English alphabetical order, three of the following four
are alike in a certain way and thus form a group. Which is the one
that does not belong to that group?
(Note: The odd one out is not based on the number of
consonants/vowels or their position in the letter cluster.)5352

A.  B. GIJ

B.  A. HJM

C.  D. EGJ

D.  C. LNQ

✓

Q100 Reasoning
Each letter in the word ECHARDS is changed to the letter
immediately following it in the English alphabetical order and then
all the letters thus formed are arranged in the English alphabetical
order. Which of the following letters will be fourth from the right in
the new group of letters thus formed?

A.  A. D

B.  D. E

C.  C. F

D.  B. S
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